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Introduction

About this manual

This manual covers how to connect an Access control unit and upgrade the firmware, I/O board firmware and
application, with Access Application Tool.

The configuration of the controller is not described in this manual. Please refer to the controller manual for a
detailed information about the controller.

Special text formats used in the manual:

 Note! This box and symbol is used to show useful tips and tricks.

 Caution! This type of text and symbol is used to show cautions.

 Warning! This type of text and symbol is used to show warnings.



About Access Application Tool

Access Application Tool is a PC-based, free configuration software tool. It is used to upgrade, configure, and
commission an air handling unit with Access controller.

Content in different Access Application Tool revisions

There are some different features support that differ between different Access revisions, see the table below

Revision Connect Easy upgrade Backup and
Restore

Commissioning re
port Trend tool

From 4.0-1-00 ✓  – – – –

From 4.0-1-06 ✓ ✓ ✓ – –

4.3-1-00 and later ✓ ✓ ✓ ✓ ✓

Install and open Access Application Tool

Start by downloading and installing Access Application Tool on your computer. Microsoft Visual C ++ and Microsoft
.Net Framework 4.8 Web are also installed on the computer (if they are not already installed).

Open Access Application Tool on your computer.

Make sure that the computer and the Access control unit you want to connect are in the same network.

Open Access Application Tool

The Access Application Tool will open the network search window at start. An automatic search of the connected
network is initiated.

From the search window the web interface of air handling unit is opened with [Connect] and firmware and
applications software updates are initiated with [Easy upgrade] or [Advanced options].

Network search

The search window close with the [X] in the header window. Search window can also be opened with the [F7] key
or from the Tools menu “Search for control unit’s”.
New network search is initiated with the [Search network] 



Air handling unit connected to a network associated within the same VLAN/IP range as the Access Application
Tool computer, lists all compatible control units.

If none or the specific air handling unit is not found, either use the

[Find more] button with specified IP address of the air handling control unit.

or

Connect computer direct to the network socket of air handling control unit and initiate a new search with

[Use direct network cable] enabled.

 Note! The Access Application Tool only finds air handling units with Access control units.

Menu description

With the search window closed or an air handling unit web page is opened the Access Application Tool menu is
accessible.

File

From menu the configuration settings of a selected air handling unit can be

saved to computer.

restored from computer to air handling unit.

generated to a printed file, so called commissioning record.

Available choices depending on target system version of application. For further information see chapter 1.2.1.

View



Select “Refresh” or press [F5] to update web page graphics.

Tools

“Search for control unit’s” or press [F7] opens the network search window, chapter 2.2.

“Trend” is available depending on target system version of application, for further information see chapter 6.

 “Options”, select Access Application Tool language out of 5 supported languages. Changed language to take

effect, restart the Access Application Tool.

Help

This manual opens with “Help” and installed version of Access Application Tool is shown with “About”.

Open user interface of air handling unit

Perform a network search, see chapter 2.2.

Select air handling control unit from listed control units. Selected air handling unit is highlighted grey, the control

unit status LED will flash.

Press [Connect].

The main page in the web interface for the air handling unit controller will open, see Figure 3-1 Web interface,
main page below.

With the web page opened the air handling units web pages and the Access Application Tool menu’s is
accessible.

Easy upgrade

The Easy upgrade consists of firmware and software application upgrade to latest installed release including



backup and restore of the air handling unit application configuration.

The Easy upgrade requires login with Admin or Service user.

Process steps of an Easy upgrade;

Find and select air handling control unit, see chapter 2.2

Start easy upgrade

Login user

Acknowledge actions

Select save backup location

Automated steps;

Save of configuration

Upgrade of firmware (IO board and EXOreal)

Upgrade of application (logic and web)

Restore of configuration

Finalize, customize and save commissioning settings

Select air handling control unit

With network search window populated with a list of air handling unit’s, select the air handling unit to upgrade. The
selected air handling unit will be highlighted with grey background in the search window list and the control unit
status LED will flash.

Start Easy upgrade

Press the [Easy upgrade] button. A password dialog opens.

 Caution! If your Access controller has static IP- addresses, make sure to write down the controller’s
network settings before upgrading. There controller might lose its settings during an upgrade and may need to be
manually configured when upgrade is done.

Confirm user rights

Enter the password for the user of Service or Admin of the air handling unit ant then press [OK].

For passwords,

default passwords, consult product documentation.

or

adapted passwords, consult the facility documentation, commissioning records or similar.



Acknowledge actions

A summary of upgrade actions and prerequisites presents together with selected air handling control unit name,
serial number, and Ethernet address in the heading of message box.

Summary of actions is for example

from/to version of firmware (if applicable)

from/to application software

backup/restore of configuration

what the update imply, by means of

password reset

deleted commissioning settings and logged data, e.g. energy insight and alarm history.

Prerequisites

ensure access to any customized Ethernet and user passwords to manually restore when air handling

control units is upgraded.

Acknowledge with [Yes] button or reject with [No] 

Select location for configuration backup file



Select location and, if needed, edit file name of the configuration backup. Proceed by pressing [Save].

Upgrade process

A pop-up window will indicate the upgrades steps and progress bars. A typical upgrade including configuration
backup, firmware, application and restore of configuration with direct network cable will take approximately 10-15
minutes.

Finalize upgrade

Pop-up window with a remainder e.g.

reconnecting IO and bus

restore any customized settings

save commissioning settings

Acknowledge finalization of Easy upgrade, with [OK] button. The Access Application Tool will connect and open
the web user interface of updated air handling control unit.



Save commissioning settings

When customized Ethernet settings and passwords, acknowledge alarms are restored, end the upgrade by saving
configured settings as backup in the air handling control unit.

Logged in as Service by selecting [Yes] for “Save commissioning settings” in the menu “Configuration>System
settings>Save and restore”.

Advanced options

 Caution! If your Access controller has static IP- addresses, make sure to write down the controller’s network
settings before upgrading. The controller might lose its settings during an upgrade, and may need to be manually
configured afterwards.

The Advanced options gives the possibility to select version of firmware and/or software application. Upgrade with
Advanced options must be used in cases when running an Access application version in air handling unit without
Access Application Tool support for backup/restore.

The Advanced options requires login with Admin user.



Process steps of an Advanced options process;

Find and select air handling control unit, see chapter 2.2

Select Advanced options

Login user

Select Access application version

Select what to upgrade

Application

Firmware (EXOreal)

Firmware I/O board

Automated steps;

Save of configuration, if selected

Upgrade of firmware (IO board and EXOreal)

Upgrade of application (logic and web)

Restore of configuration, if selected

Finalize, customize and save commissioning settings, see 4.4

The [Advanced options]- button on the network search screen will open an Advanced options menu (Figure 5-1) for the
selected Access control unit.

Select version

Select the version you want to upgrade to. Older versions are available.

 Caution! To downgrade to an older version is an advanced operation and should only be attempted by
qualified personnel. Access will not work correctly if parts of the application and firmware have different versions
installed.

Upgrade application



The [Upgrade application]- button is used to upgrade the firmware, I/O board firmware and application.
It is optional to include backup and restore of configuration settings.

Backup settings

When the [Upgrade application]- button is selected a pop-up window will ask if you wish to backup the settings
or not see Figure 5-2 below.

[Yes] backup and restore of configuration settings included in upgrade process.

[No] there will be no backup and restore of air handling control unit. Application will upgrade according to the

application defaults.

Upgrade application

The upgrade consists of five steps:

1. Reading backup from controller, if selected

2. Upgrade firmware and I/O board firmware

3. Upgrade application

4. Upgrade application web

5. Writing backup to controller, if selected







Upgrade Firmware only

[Upgrade firmware] for update of the firmware. It is also possible to upgrade the I/O board with this function.

The [Upgrade firmware] include an optional selection to backup the configuration settings, see Figure 3-12
below.

Backup/restore of settings



With [No] selected, the application tool will proceed with the firmware upgrade, Figure 5-14.
With [Yes] selected, the upgrade including backup and restore of settings will start, see Figure 5-13 below.
Process consists of three steps:

1. Reading backup from controller

2. Upgrade firmware

3. Writing backup to controller

When reading backup from controller is done the application tool will proceed with Upgrade firmware.

The process steps for upgrading firmware’s open new pop-up windows. Select the firmware (Main board CPU)
and the I/O board CPU to upgrade, see Figure 5-14 below.

With button [Change new revision], select from available revisions of specific firmware.

When the firmware is upgraded, the program will write the backup to the controller.

Note! The Firmware upgrade window will close after 30 minutes of inactivity, regardless of whether the upgrade
is finished or not. Please check the progress of the upgrade continuously to prevent the upgrade from stopping
prematurely

Upgrade I/O board firmware

Press the [Upgrade I/O board firmware] button in the Advanced options menu to upgrade the I/O board to the
latest version, see Figure 5-1.



Trend tool

The trend tool in Access Application Tool is used for live trending analog and digital signals.

The Trend tool is started from Access Application Tool via the Tools menu. When option is not available to select,
the function is not supported by the current version of the application.

Buttons in the chart



1. Reset the zoom of the X- and Y- axis on the analog chart to the default value.

2. Freeze the zoom on the X-axis (time). The x-axis is not moveable.

3. Freeze the zoom on the Y-axis (value). The y-axis is not moveable.

4. Options: Add/remove axis and Associate variable with axis. See 4.2.1.

5. Remove analog variables

6. Reset the zoom of the X- and Y- axis on the digital chart to the default value.

7. Remove digital variables

Menus

Table 1 Top menu description



File menu Analog menu Digital menu

Option Explanation Option Explanation Option Explanation

Export all to fil
e

Export analog a
nd digital values
into an Excel spr
eadsheet

Export to file
Export analog v
alues into a Exc
el spreadsheet

Export to file
Export digital val
ues into a Excel 
spreadsheet

Delete all
Delete all variabl
es from both cha
rts

Export to imag
e

Save the chart a
s a . png file

Export to imag
e

Save the chart a
s a . png file

Sample interva
l

A popup window
with the option t
o set the sample
interval in secon
ds (1…600 s).

Associate varia
ble with axis See 6.2.1 below Reset chart

zoom

Reset the zoom 
to the default val
ue

Clean chart

Remove all valu
es from the char
ts, but will keep t
he variables.

Add/remove ax
is See 6.2.1 below Delete chart

Delete all the Di
gital
variables/values
from the chart.

Exit Close the applic
ation

Reset chart
zoom

Reset the zoom 
to the default val
ue

  

  
Show NaN! Val
ues

Instead of leavin
g a blank space 
when a variable 
has a NaN! valu
e, this will

replace that blan
k space with -1e
6.

  

  Delete chart

Delete all the An
alog
variables/values
from the chart.

  

Add/Edit/Remove axis

From Analog menu or the icon  below the analog chart, following three options available: Add, Edit and
Remove axis.

Add axis:



1. Name the axis

2. Select the position of the axis (Left or Right)

3. If the checkbox Manual (5) is selected, define min and max values for the axis (3, 4)

4. Select Create (6) to create the axis or Cancel (7) to cancel.

Edit axis:
Change position, right/left and min and max value. By clicking the button “Apply” the changes will be applied.

Remove axis:
By selecting an axis and the Remove button.

Associate variable with axis:
A popup will appear with the option to associate a variable with an axis

By clicking on the variable drop down arrow (1) a list of the variables will be displayed.

It is possible to associate with a specific axis by clicking on the axis drop down arrow (2). A list of all the axes that



are created will be showed.

Add a variable

To add a variable too the chart:

1. Open the tree view “Data & Settings”

2. Browse and select variable to add. In the example in Figure 6-5 Add a variable to trend chart it is the analog

variable Exended operation.

3. A small popup window is shown, where you select Add.

4. The variable will then be shown at the bottom of the chart as seen embedded in Figure 6-5.

Delete variable

Note! If variables are removed from the chart, the trend data disappears if they are not first exported!

Delete one variable

Two ways to delete a single variable:

1. Select the variable in the tree view and choose Remove.

2. Select the trash icon in the bottom of the screen. A popup window with the available variable is shown.

Click on the variable you want to remove to delete it from the chart. See Figure 4-6 below



Delete all analog or all digital variables

Delete all analog variables from the chart:

1. Select Analog in the top menu

2. Select Delete chart.

To delete all digital variables, select Digital in the top menu, and then Delete chart.

Delete all variables



To delete all variables (both analog and digital), select File in the top menu. Then choose the option Delete all.

Other features and tips

Zoom: Scroll the mouse to zoom in or out.

Move the chart: Click on the chart and move it around.

Tool tips: By moving the mouse over a curve a tool tip will pop up, with information about date, time and value.

Use Export to file for a CSV file export and Export to image for saving a screenshot of active trend chart.

Amount of sample data:

the number of points varies depending on the number of signals selected and the sample rate.

The tool may be slower with more samples, and the recommendation is to not exceed 1.5 million

samples.

The tool will use about 800 MB of computer RAM when logging 1 million samples.

Example: With the sample rate 1 s, every signal will store about 75K samples every day. 16 signals will

then store 75K x 16 = 1.2 million samples.

Manual backup and commissioning report

Access Application Tool makes a backup of the controller automatically when the Easy upgrade function or the
Upgrade application function is selected (see 2.2 and 5.2 above).

It is also possible to read the backup and write a backup manually from the File menu, see Figure 7-1 below.

Commissioning record

Under the File menu in Access Application Tool, it is possible to generate a commission record. The record
consists of a pdf-file with the current values and settings read from the controller.

If the option is dim grey, the function is not supported by the current version of the application.



Uninstall Access Application Tool

 Warning! If you uninstall Access Application Tool, the other Regin programs on the computer will stop
working since they share information. The other programs can be reinstalled after Access Application Tool has
been removed and will work properly again.

Uninstallation of Access Application Tool from your computer needs to be done in steps, since there can be files
left on your computer after you have removed the program itself.

1. Uninstall Access Application Tool from the Windows control panel on your computer (Settings ► Apps and

features) or by right clicking on the name in the Windows start menu.

2. Open the File explorer in your computer and remove the file products.dir from

C: ► Program ► Regin ► System. See fig below

3. When Access Application Tool is installed, the programs Microsoft Visual C ++ and Microsoft .Net

Framework 4.8 Web are also installed on the computer (if they are not already installed). These programs must

be manually uninstalled. Make sure that the programs are not being used by some other application if you

choose to uninstall them.

Troubleshooting

Problem with web interface after version change

When the program has been upgraded to a new version, there might be a problem with the web interface.



Try restarting Access Application Tool to resolve the problem.

Issues with installation due to antivirus program

A problem can occur with the installation of Access Application Tool when there is antivirus software installed on
the computer.

Solve the issue by disabling the antivirus software during installation.

Also, make sure that the Regin folder (e.g. C:\Program Files\Regin\) is in the list of trusted programs/files paths.

Customer Support

Systemair Sverige AB
Industrivägen 3
SE-739 30 Skinnskatteberg

+46 222 440 00
mailbox@systemair.com
www.systemair.com

© Copyright Systemair AB
All rights reserved
EOE

Systemair AB reserves the rights to alter their products without notice. This also applies to products already
ordered, as long as it does not affect the previously agreed specifications.
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http://www.systemair.com
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